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Agenda

« Why RDi
* What’s New in 9.6 — November 2017
e Eclipse
* IBMitooling
* Code Coverage

* ACS Integration
* Modernization Tools, Java Edition

 Feedback and direction setting
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RDI currency

Which is most recent version actively used in your shop?

1. Green screenonly (1970-1990)
2. CODE/400 (1990-2000)
3. WDSc (2000- 2009)
4. RD Power 7.x or 8x (2010-2012)
5. RDi9.0.x (2013)

6. RDi9.1.x (2014)

7. RDi9.5-9.5.0.3 (2015 Sep)
8. RDi9.5.1-9.5.1.2 (2016 Sep)

9. RDi 9.6 (2017 Nov)

© 2016, 2017 IBM Corporation
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Top Concerns for IBM 1 IT — Help Systems Survey 2016

_ 58.3% Modernizing applications
_ 39.2% High availability
_ 37.7% IBM i skills depletion
_ 30.0% Reduce IT spending
_ 29.5% SQL database access
_ 26.3% Analytics/business intelligence beyond Query/400

© 2016, 2017 IBM Corporation
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Top Concerns for IBM 1 IT — Help Systems Survey 2017

71.3%

59.4%

35.4%
o
29.4% 28.7% 25.7% 0
24.2% 23.5%
18.1%
11.5% 10.8%
N
Security High Data Reduce saL Analytics/ Compliance Mobile Cloud Document Enterprise Other

Availability Growth IT Spending Database Business and Accass Computing® Management  Systems (Write-in)

Access Intelligence Regulations Management

* backup and'recovery; Tools and SLA

managed services, and Saas Management
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Modern RPG — Constant Transformation

© 2016, 2017 IBM Corporation 6
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Roadmap to Modern RPG

« Modern coding style
— Easier to code and maintain

— Easier for new programmers
« But older code still works
« Easily express business logic

© 2016, 2017 IBM Corporation

7.1

= Free-formH, F, D and C
statements

= Removal of 8-80 column limit

= Sort and search data structure
arrays

= Sort ascending or descending

= %SCANRPL built-in function

= Support for ALIAS names in files
and data structures

= Relaxed rules for data structure I/O

= Faster return values with
RTNPARM

= %PARMNUM built-in function
= Optional prototypes

= Implicit CCSID conversion for
parameters

= Teraspace storage model

= CCSIDCVT keyword to notify about
conversion errors

= Encrypted listing debug view

7.2
= CCSID support for

alphanumeric data

= Alphanumeric subfields in

external data structures
can have the same CCSID
as the field in the file

= Implicit CCSID conversion

for concatenation

= Option to open database

files without CCSID
conversion

= /SET and /RESTORE

directives to temporarily
change the default CCSID
or date/time format

= More control for %SUBDT
= 0 and 12 fractional

seconds for timestamps

New and enhanced built-
in functions to improve
string processing

Use ALIAS names for all
externally-described files
Relaxed rules for data
structures for I/O
operations
Enhancements related to
null-capable fields
Usability enhancements
for generated PCML
Maximum number of
parameters for a bound
call increased to 16,382

Nested data structures
without LIKEDS

New %MAX/%MIN BIFs

ALIGN(*FULL) extends DS
length to match alignment

%PROC return external
proc name

Complex names for
%ELEM/@SIZE/DEALLOC,
RESET

PCML 7.0 support

Supported in
RDi 9.5.1.2

Supported
in RDi 9.6


https://www.ibm.com/support/knowledgecenter/ssw_ibm_i_73/rzasd/freesubfield.htm#freesubfield__nested
https://www.ibm.com/support/knowledgecenter/ssw_ibm_i_73/rzasd/bbmaxmin.htm
https://www.ibm.com/support/knowledgecenter/ssw_ibm_i_73/rzasd/dalign.htm
https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/We13116a562db_467e_bcd4_882013aec57a/page/%25PROC%2C%20more%20uses%20for%20complex%20qualified%20names%2C%20PCML%20support%20for%20varying-length
https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/We13116a562db_467e_bcd4_882013aec57a/page/%25PROC%2C%20more%20uses%20for%20complex%20qualified%20names%2C%20PCML%20support%20for%20varying-length
https://www.ibm.com/developerworks/community/wikis/home?lang=en#!/wiki/We13116a562db_467e_bcd4_882013aec57a/page/%25PROC%2C%20more%20uses%20for%20complex%20qualified%20names%2C%20PCML%20support%20for%20varying-length

Fu ” Free FOt‘m RPG Cognitive Systems@

ctl-opt bnddir('ACCRCV'");

read custfile custDs;
dow not %eof;
if duebDate > %date(); // overdue?

o o
dcT-f custfile usage(*update); com Ilero tlons
dcT-ds custDs;
dc1-f report printer;
File Definitions
sendoverdueNotice ();
write reportFmt; oq0
exec sgl insert :name, :duedate into
mylib/myfile;
endif;
read custfile custDs; 140
Prokedure Definitions
dcl-proc sendoverdueNotice;
/copy invoices
sendInvoice (custDs : IS_OVERDUE); alc ecs
end-proc;

inlr = "1";

© 2016, 2017 IBM Corporation
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Development tools....
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=0 Session & - [24 x 80]
[ . : b

B Th

gram: ORDENTR

firm an order.

I
The progr

m
=Repeat find
s |

=]

Tried and True, Yes but also SLOW, OLD, No new features
Don’t let SEU hold you back!

http://ibmsystemsmag.com/blogs/idevelop/april-2017/seu-was-holding-me-back/



http://ibmsystemsmag.com/blogs/idevelop/april-2017/seu-was-holding-me-back/
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Ratlonal Developer for |

Modern, Eclipse-based, development tools for IBM i
* Visual editors, outline views, content assist, hover/hyperlink, integrated language help
* Integrated file management, search, edit, compile/build, debug capabilities
* Analysis tools (application diagram, call hierarchies, type hierarchies)
* Easily debug batch, interactive, and Web applications with a common visual debugger
* Analyze code coverage of tests
* Visual DDS design tools: Screen and Report Designer
* Supports RPG, COBOL, CL, C, C++, SQL, DD_Sm

| [ Remsie Sptem Bieer]
4

“ Usethe Right Tool for
| the Job!

©2016, 20171~ oo ghos e 11
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8.5.1

= Live ILE RPG
outline view

= |IBM Data
Studio included

= 64-bit operation
system support

=8 RFEs

= 36 fixes

© 2016, 2017 IBM Corporation

Rational Developer for i RoadMap

« Tightly integrated

« Edit/Compile/Debug

» Program Understanding

» Code Coverage Analysis

« Extensible by ISVs

+ Extensible by open source

9.1.0
= Code
Coverage
9.0.0 = Search/Filter
= Hover/Hyperlink within ILE RPG
to RPG outline view
definitions = Quick open for
= Improved browse
Content Assist = F1 help on
= Improved CL RPG opcode/
support keyword/ BIF
=9 RFEs =7 RFEs
= 39 fixes = 46 fixes
9.11
9.0.0.1 = Configuration
= 11 fixes backup and
distribution
9.01 = Code
= Free-form ILE Coverage for
RPG interactive jobs
declarations » Mark
= Improved occurrences of
syntax all RPG
highlighting declarations in
= Improved editor
visualization = 8 RFEs
of block = 57 fixes
nesting
=4 RFEs
= 49 fixes 9111

» 14 fixes

Value Proposition

=Fully Free
RPG - no
column
restrictions
=Integrated
5250 emulator
=|LE RPG
indentation
action
=Update
Notifier
=Eclipse 4.4.2
=10 RFEs

=52 fixes

9.5.0.2

=Better context-
sensitive help and
content assist
=Improved
indentation support
=21 fixes

=9.5.0.3
=L anguage support
i7

for IBM i 7.3

=*Windows 10
support

=Launch Run SQL
Scripts from
SQLRPGLE
sLaunch Printer
Output from RSE
=Show block
nesting, also shows
which procedure/
subroutine

=Push to Client
saves custom
perspectives
=Enhance language
sensitive help for
embedded SQL in
RPG

=31 fixes

951
= Mac Support

= Kerberos
Support

= Synchronize
Eclipse projects
with IFS
= RPGLE outline
= Full O-Spec
support
= Full I-Spec
support
=Filter out
unreferenced
= Comment
shortcuts for
CLLE and DDS
= Syntax error
annotations
= More
parameter info in
content assist
= Integrated
ACS supports
Visual Explain

= 18 RFEs
= 4 features
=19 fixes

9.5.11

*RPG
Refactoring —
Rename
Variables

= Default to
Browse
preference

= Kerberos fixes

=7 RFEs

= 19 fixes

9.5.1.2

= Nested Data
Structures in
RPGLE

= %MAX/%MIN
BIFs

= ALIGN(*FULL)

= Support for
*LIKE DEFINE

= Trim leading
spaces on line
join Alt-J

=4 RFEs

= 28 fixes

9.6

= Compare/Merge
members

= Error Annotations

= [LE RPG Rich
Hover

= [LE RPG Unused
Var Warning

= |LE RPG key
behaviour
updates

= iProject
improvements

=ACS 1.1.7.1 and
additional actions

= IBM i command
line code
coverage tool

= %PROC BIF

=WAS 9

= Eclipse 4.6.3
=12 RFEs

= 40 fixes

12


http://www.ibm.com/support/knowledgecenter/SSAE4W_9.5.0/com.ibm.etools.iseries.rse.doc/topics/acs_run_sql_scripts.html
http://www.ibm.com/support/knowledgecenter/SSAE4W_9.5.0/com.ibm.etools.iseries.rse.doc/topics/acs_ovr.html
http://www.ibm.com/support/knowledgecenter/SSAE4W_9.5.0/com.ibm.etools.iseries.rse.doc/topics/tblock_nesting.html
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Where to get RDI

 Trial— Nov 16 https://www.ibm.com/developerworks/downloads/r/rdi/
— Web Install (for manual web install you need Installation Manager 1.8.7 minimum)
— Product zips download

* Passport Advantage — Nov 16
— Product zips and activation kits

e Entitled Software Site (ESS) — Nov 21
— Product zips and activation kits

* To install Rational Developer for i at the latest level on multiple developer
machines, see http://www-01.ibm.com/support/docview.wss?uid=swg2 1668005

© 2016, 2017 IBM Corporation 13
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Editions

 Based on Eclipse 4.6.3

 For 9.6, the editions available are:
— RPG and COBOL Tools
— Modernization Tools, Java Edition

* No Modernization Tools, EGL Edition for 9.6

e All editions currently bundle in IBM Data Studio 4.1.2
— Not updated for Eclipse 4.6 so do not shell share **high priority issue™*

© 2016, 2017 IBM Corporation



Cognitive Systems@

RDi 9.6 Platform support

e Added Mac 0S 10.12
— Dropped Mac OS 10.11.

e Linux

— Dropped several versions.

— Supported: Red Hat (RHEL)

e  Windows

Ubuntu

7
16.04 LTS

64-bit
64-bit

— Dropped 32-bit Win 7. Dropped Win 8. Likely to drop 32-bit JDK.

© 2016, 2017 IBM Corporation

7

8.1

10

Server 2016

64-bit
64-bit
64-bit
64-bit

32,64
32,64
32,64
32,64

Lo

15
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Eclipse 4.6.3

= IBM i RSE Getting Started # *EMPTY4.RPGLE # PAYRPIILCC DRAILE 57 | £ crsnmvo oocic
. Close I
. Line 25 Column 14 Replace
e Editor Close Tabs to the Cvteode Wi Benntes3e..4..., (CloseOthers 7
PPR10O **FREE Close Tabs to the Left
|eft/r|ght P00101 ctl-opt Dftactgrp(*no); Close Tabs to the Right
BRR1AZ [/ FEEERRERRROER R KRR KRR
000200 // PROGRAM NAME - Payroll <l
Pee308 [/  DESCRIPTION - Time reporting master file maintenance using
eeedee [/ externally described workstation processing.
BOB5AA [/ FEEERREROOEEERRRRR RO R R RO R R RO R R R
poeeRe [/ INDICATORS USED

* Print toolbar button now
hidden by default

— Customize Perspective to
add it back to the toolbar

© 2016, 2017 IBM Corporation

@ Customize Perspective - Remote System Explorer

Tool Bar Visibility | Menu Visibility | Action Set Ava

Choose which tool bar items to display.

Tool Bar Structure:

4 File
|| New Wizards
LEJ Save
V|2 Save All

& Print (Ctrl+P)

16
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Eclipse 4.6.3

Settings Transfers

To save space in the toolbar, the perspective switcher has been changed to When vou switch vour workspace you can select settings than will be transferred to
show only the icons of perspectives by default. You can show the text again via the new workspace. These settings are supplied by the
the context menu org eclipse vt preferenceTransfer extension.

New default: The SDK supplies transfers for:

+ Workspace Layout: Opened views, their size, and selected perspectives.

. e + Working Sets: The user defined working sets.
5 B 45 |
@ Eclipse Launcher @

Old default: Select a directory as workspace

[BM Rational Developer for i uses the workspace directory to store its preferences and development artifacts.

st ‘ [E Remote System Explorer ] i Projects =5 DDS Design # Debug Workspace: CAUsers\IBM_ADMIN\BM\rationalsdp\workspacerdigoct23| +

~ Recent Workspaces
workspacerdi96oct23b
workspacerdi96oct?3c
workspacerdi%6oct23

~ Copy Settings

[ Workbench Layout

|1 Working Sets

@ OK ] l Cancel

© 2016, 2017 IBM Corporation 17



)
Cognitive Systems =

Syntax Errors as Annotations

* Syntax checker errors used to be
shown a pink lines inserted into
the source

* Now you can choose to show
them as annotations instead

 The annotations are specific to
the column range and move
with the tokens in error

DCL-DS *N;

DCL-DS *N;
DCL-SUBF select CHAR(10);
name CHAS(1@);
RNF3308E Keyword name is not valid; the keyword is ignored.
END-D ;
RNF5347E An assignment operator is expected with the EVAL operat

1 retrncs T S o —

Parsers IBM i Parsers
4 LPEX Editor . - o 5
P See 'Parser Associations’ for associating a document type with a parser.
arsers

See 'Parser Styles' to change colors for tokens in individual parsers.
4 Remote Systems

4 Remote Systems LPEX Editor

IBM i Parsers
[] Add signature to changed lines for RPG/400, ILE RPG and DDS parsers
Show Block Nesting -
[ Display syntax check messages as annotations I
DCL-DS *N;

DCL-SUBF select CHAR(10); [ DCL-SUBF select CHAR(18);
X name CHAS(10); €  |RNF3308E Keyword name is not valid; the keyword is ignored.

el ClioDC AAdnA-r CFUAD ST

© 2016, 2017 IBM Corporation

nel -sHRF addrecs CTHARM?5Y -

18
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Compiler/Verifier Errors as Annotations

* This was requested as RFE82757 because the error location is out of
date after line addition/deletions

* To configure use the Error List view menu
»_lOz Error List 33 ].__;, Code Coverage Results = ” H

Show Severity

Severity  Line Location Connec Messages
Automatically Remove

Automatically Insert
Show messages as annotations I Message Style
- T

Tl v v v
i

 The hover will show you the all the errors and give you a link to get
the language helpp

= g Data Struct
i del-pr Functiond 1ikedx(dsi); [T
end-pr;
dcl-ds dsl qualifiel @ RMF3308 - Keyword name is not valid; the keyword is ignored.
i Hs2 likeds(ds2);

end-ds: —
© 2016, 2017 IBM Corporation 19
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Unused ILE RPG variables are annotated

If a declaration is never
used, an informational
annotation is given

This behaviour can be
configured on or off

© 2016, 2017 IBM Corporation

dcl-dsadsQual qualified; - v L."_]Db.al vennitiens
i quall char(3); = [ Files
subl Flobo o

End-Ds| i The subfield quall in the data structure dsQual is not used

Icustrec
I

Press 'F2' for focus

T TuTT TTT

@ Preferences

type filter text
4 Remote Systems +
Communicatior
DataStore
» Debug
File Cache
Files
» IBM i
Logging
Passwords
» Remote Reconc

Remote System| =
4 [BM 1 Parsers
> CfC++
CL
» COBOL

= ]
ILE RPG BRI T

Automatic syntax checking
Automatic syntax checking of SQL statements (performed on the server)
[] Automatic uppercasing
[] Show lowercase values in dropdown menus in Source Prompter
Block comment behavior
Fixed format
@) Insert * into column 7 and shift line by one column
() Overwrite blanks in column 7 with *
Free format
@ Insert // at beginning of line and shift line by two columns
() Overwrite blanks at beginning of line with //

Update the Outline view when text is changed in the editor
|| Categaorize na_med indicator as Fields in the outline view.

DDS

‘[ [] Annotate unreferenced definitions ]

»|ILE RPG
RPG/400 ~

4 111 3

lRes‘[ore Defaults‘ \ Apply ‘

o J[ canca | 20
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Rich ILE RPG hover showing all contributing
deflnltlons

Variables may have non-obvious relationships with external
definitions

* The hover will show all contributing definitions with resolved
externals

dcl f custl dlsk renaweﬂcustnmﬂl : custrec);

ICUSTREC
I custna !ust_name

cust_name = "Maha';

cust mame : Character (40)
Defined by:

cust1/custrec - External: ECLIPSTEST/CUST1/CUSTOMO1/CUSTMA
Renamed by:

cust name - on Input specification custrec
Press 'F2' for focus

© 2016, 2017 IBM Corporation 21
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Rich ILE RPG hover — parent data structures

* Show relationship with parent data structures

© 2016, 2017 IBM Corporation

dcl-ds dsl qualified;
nested likeds(ds2);
End-Ds;
dcl-ds ds2;
subfield int(5);
End-Ds=;

ds1.nested.subfield = "abc’;

Contained by:

subfield : Integer (5,0}

dcl-ds ds1 QUALIFIED;
dcl-ds nested LIKEDS(ds2);

Press 'F2' for focus

22
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9.6 Comments now shown in hover

// The following statements perform

//  two functions. First they determine the type of maintenance

// requested and branche to the appropriate subroutine and secondly
[/ they determine if the maintenance code entered is invalid.

: 1/
i Select;
When ACODE = "A';
i validfiteAdd();
i When ACOf= =
' Valida| ValidateAdd
: When J':\EO The following code verifies the add request.
I valida Input:
) Other; nput
_ Displa ACREC is the recorded state of the employee
! Endsl; ‘A’ means added
¢\ End-Proc; ‘D" means deleted
// *IN50 indicates the record is not found
v // The folf Qutput:
LSS If an error occurs, the EMESS field contains the appropriate message
_ . Press 'F2' for focusi
BN Tarks [A Nhiart T Fil rasmeas JB] Tarminale 3| Conne Lict E Drnnrace

© 2016, 2017 IBM Corporation
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Sound effect with hover

* On Windows, sound effect might
occur with displaying the hover
information

* To turn off the ‘click’, go to
Control Panel > Sound > Sounds (tab)
> Windows Explorer > Start
Navigation, and set to None

© 2016, 2017 IBM Corporation

‘i Sound

PlaybacklRecording Sounds | Communications

==

A sound theme is a set of sounds applied to events in Windows and
programs. You can select an existing scheme or save one you have

modified.

Sound Scheme:

Windows Default (modified) (mo VI I Save As.. H Delete

To change sounds, click a program event in the following list and
then select a sound to apply. You can save the changes as a new
sound scheme.

Program Events:

------ ﬂ Feed Discovered

------ ﬂ Incoming call

------ Move Menu Item

------ ﬂ Motification bar

------ Search Provider Discovered

------ tﬂ Start Navigation ]

m

DPIay Windows Startup sound

Sounds:
[(None] 'l Browse...
[ oK l [ Cancel ‘ l Apply

I
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ILE RPG Key behaviour preference page

@ Preferences

type filter text

Consolidate key
behavior preferences

4 Remote Systems
Communications
DataStore

> Debug
File Cache

Add Enter key splits line

» BM i

» Remote Reconciler
4 Remote Systems LPEX Edito

for free form source

Add Tab key inserts
spaces for free form o

» COBOL

source oo

4 ILERPG
Content Assist

1

Formatter

Free-form SQL Forr

Key Behavior

Templates
RPG/400

SSL/TLS -

€ T 3

@

© 2016, 2017 IBM Corporation

Key Behavior

| Alt-S action splits the line and shifts the text on the new line

key behaviar
| Enter key splits line for free form source ]

[¥] Repeat previous specification type

Repeat previous operation code (if on fixed form C-Specification)

Set C-Specification cursor position

Set D-Specification cursor position

| Automatic indent

| Automatic closure of control block

See 'Formatter’ for number of spaces.

Style: |ENDXX -

Tab key behavior
[7 Tab key inserts spaces for free form source. ] See [Formatter’ for number of spaces.
[ TUser detined tabs
H: Contro A
Comments
0
|Re5tore Defaults| | Apply |
I oK l ‘ Cancel ‘

25
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Compare/Merge of members with sequence numbers

© 2016,

When comparing two members from Remote Systems view (Compare
it is now editable and Copy actions in toolbar

With > Each Other),

48 Remote Systems \ % Team

£ 8|
> [ PAYROLLCS*pgm.cblle
[ PAYROLLC7 *pgm.cblle
» Bl PAYROLLD.*pgm.chlle
+ [ PAYROLLFFF.*pgm.rpgle
» [ PAYROLLFFG.*pgm.rpgle
> [ PAYROLLG.*pgm.rpgle
. [ STRCODECPP.*pgm.clp
- Eo COMPARE *file.pf-src
. [ EMPMST.#ile.pf-dta
- [ EVFEVENT *file.pf-dta
» [ LISTINGS *file.pf-dta
» 6% MSTDSP.*file.dspf
+ 6 MSTDSP2 *file.dspf
. @ PRIMST #file.pf-dta
- E QCBLLESRC *file.pf-src
» Eo QCLSRC Hile.pf-src
- E QCMDSRC *file.pf-src
» 0 QDDSSRC.Hile.pf-src
Eb QLONGSRCPF *file.pf-src
@ PAYROLLFFF.rpgle
5 QRPGLESRC *file.pf-src
% PAYROLL.rpgle
Gz PAYROLLFF.rpgle
G PAYROLLFFG.rpgle
% PAYROLLG.rpgle
- Ea QRPGLESRCP*file.pf-src
» @ REFMST *file.pf-dta
» & RSNMST *file.of-dta

S

lBls ~

-

111

fia IBM i RSE Getting Started

# IBM i Member Compare ¥

£ Compare (PAYROLLRPGLE' - 'PAYROLLGRPGLE') &

_Mdlw 3= <

= O

LBt

[ C* The following test code verifies the change |- C* The following code verifies the change re| -
c* C*
C CHGCDE BEGSR c CHGCDE BEGSR
C IF *IN5@ C IF *INS@
C EVAL *IN6@ = *ON c EVAL *IN6® = *ON
c MOVE ERR(7) EMES C MOVE ERR(7) E
C ELSE C ELSE
C IF NOT *IN58 AND ACRE C IF NOT *IN5@ AND A
C EVAL *IN6e = *ON C EVAL *IN6® = *ON
c MOVE ERR(8) EMES c MOVE ERR(8) E
C ENDIF C ENDIF
C ENDIF C ENDIF
C ENDSR C ENDSR
/FREE /FREE
/r* /r*

//* The following code verifies the delete re
//* protect indicator *IN9@ is first set on (
//* allow changes to existing data on a delet

/r*
BEGSR DELCDE;
*IN9@ = *ON;
IF *IN5S@;
*IN6@ = *ON;
EMESS = ERR(9);
ELSE;
IF NOT *IN58 AND ACREC =

4 1

'‘D':

//* The following code verifies the delete
//* protect indicator *IN9@ is first set o
//* allow changes to existing data on a de

/7*
BEGSR DELCDE;
*IN9® = *ON;
IF *INSO;
*IN6@ = *ON;
EMESS = ERR(9);
ELSE;
IF NOT

*INS@ AND ACREC = 'D':
1

11
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Compare/Merge of members with sequence numbers

 With IBM i Member Compare’ sequence numbers and date info are hidden
and properly handled

 With ‘Text Compare’ sequence numbers and date info are shown and YOU
have to properly manage them

© 2016, 2017 IBM Corporation

[ BsMDeveionmeny PAYROLLRPGLE P E  # ANNOTA GLE IEE'Compare (PAYROLLRP.. &2 | = O
# Text Compare ~ IEEERI- R Y
Default Compare
518851808E 5 vember Compare TINE 51805100000008 * MAIN SUBROUTINE -
52 9852000€ BEGSR 52005200000000 c MAIN BEGSR
e dou *T 53805300030715 C dou GWARNING @
54065400030715 c EVAL *T 54805400030715 c EVAL
55005506030713  C EVAL EM | 55005560036713 € EVAL This source contains sequence numbers which are not automatically maintained using the
56965600030713 o EVAL EM 56005600030713 c EVAL i ; ; ; . ;
| 5786576171616 c Edrdrdr PR 57605760636713 C EVAL Text Compare viewer. The user is responsible for keeping the sequence numbers in
58005800038713 C EVAL RS 58805800038713 C EVAL ascending order and the change date accurate. Missing or out-of-date sequence numbers
59 965900000000 c* 59 805900000000 c* ; :
50 066600000000 C* Write the SELECT format to d 60 806000000000 C* Write the SELECT formg e
61066100030715 c* 61006100030715 c*
62 006200000000 C* 62806200000000 c*
63006300030715 o DOU no 63 006300030715 c DOU Do not show this again
64 006400000000 o EXFMT SE 64006400000000 c EXFMT
55 966500000000 o *INKC IFEQ ' 65 806500000000 C *INKC IFEQ
66 066600030713 c LEAVESR 66 006600030713 c LEAVEY
57 866700000000 o ELSE 67 806700000000 C ELSE
65 066300000000 c EXSR ED 63 006800000000 c EXSR
69 086900000000 C END 69 806900000000 C END
76 067600000000 c* 76 007000000000 c*
71 007100000000 C* IF the general error indicat 71007100000000 C* IF the general error indi
72 007200030715 C* program continues to loop 72807200030715 C* program continues to loop

28



Y

Cognitive Systems =

| Project Build and Retrieve Errors shortcuts

 Can now build and get error feedback without leaving the editor or

keyboard

e Alt-Shift-B — builds the project
e Ctrl-Alt-R — retrieves the errors into the editor

Remote Actions

Team

Restore from Local History...
Enterprise Extensions
Compare With

Configure

Wicnializa Ammlicatins Mizarams
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Work With Compile Commands...

Compile

Push Changes
Push Selected

Submit Build Command

Retrieve Errors

Alt+5Shift+B
Ctrl+Alt+R
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Set associated connection and library on
multiple 1 Projects at once
* If you are extracting many projects from source control, you can now

set the associated library/connection in one shot as the action
supports multiple selection

48 Remote S 2@ iProject.. 5% |E& Team Art = 0
| g | S @Associate I Project Connection and Library @

[r_'é_,f'-ﬂailli T T ) B - T B |

[ Payro = > Connection: IBM i Development Machine V‘ ‘ New... ‘
Import Remote Source... Associated library: libname Browse...
Import Remnote Objects...
Show Remote Objects
Associate Connection and Library... OK l | Cancel ‘
A Cocmr e Bl serbrre el P
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% PROC Built-in function

*  %PROC Built-in function supported in editor

0431064

c = %proc();

043105
043200
043300

A2 A

< |

Com.. =% | &

© 2016, 2017 IBM Corporation

& %proc

(| »

Yeparms |
Zeparmnumiparameter-name)
Yepaddr(string|procedure-name)

Ko

Ko

Ko
a‘“%abs{numeric—expression)
£%addr(variable)
a‘“%addr{vawing—ﬁeld : *data)
£%alloc(number)

Ko

Zebitand(expression:expression{:expres: -

%PROC

%PROC returns the external name of the procedure.

For ... &, Remo... [E: Remo... B Remo...
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Command Line Code Coverage

Code coverage added to RDi in 9.1 and updated in 9.5 with significant performance
boost. Covers batch, interactive, SEP.

PTFs are now available for RDS with command-line Code Coverage tool
Use RDi to view the results

Enables you to include code coverage runs in your builds

Freely available with RDS option 60 on the IBM |

V7R3  PTF5770WDS S165229 2924 PTF 5770WDS S164655
V7R2  PTF 5770WDS S165228 2924 PTF 5770WDS SI64544

Full details: https://www.ibm.com/developerworks/community/files/app#/file/d54ac305-6ca0-4ba8-9552-e61f6c88331b
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Requirements on job environment

* Programs and service programs for instrumentation must be compiled with one of the following
debug options:

« DBGVIEW(*SOURCE)
* DBGVIEW(*LIST)
* DBGVIEW(*ALL)
* Headless code coverage tools are located under the QDEVTOOLS library
e Add it to the library list: ADDLIBLE QDEVTOOLS
* Main command: QDEVTOOLS/CODECOV

© 2016, 2017 IBM Corporation
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Code Coverage Mandatory Parameters

e Two parameters are mandatory:
* Command to run: The full command line that will run in code coverage instrumentation mode

* Use CALL command for running a program, specify program parameters using the PARM
parameter:

e CALL LIBNAME/PGMNAME PARM(...)

* Also support customized user command:
e MYCOMMAND MYPARM(...)

*  Command length restriction: 6000
* At least one entry in the MODULES list

* Include at least one program or service program for code coverage instrumentation
* Does not have to be the main program
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Code Coverage Output options

* Two parameters to control output options:
*  Output directory and Output stream file
* They cannot be specified at the same time
* Error message is issued if they are specified at the same time:
* Parameters OUTDIR and OUTSTMF cannot be used at the same time
*  Output directory:
* Code coverage result file is saved to this directory.
* Use generated name for code coverage result file
* Generated result name format:
* ProgramName_TimeStamp.cczip
* The default output directory is *CURRENT.
*  Output stream file:
*  Fully qualified IFS file name for code coverage result file
* If the base name does not have extension
* Extension .cczip is appended to the base name
* If the base name has an extension, it must be .cczip, otherwise an error is issued:
* The extension for the result name ... is not .cczip.

© 2016, 2017 IBM Corporation
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Viewing code coverage results on RDi

* Steps to view code coverage results in RDi:

Create a local or IFS directory and store all the *.cczip files there

Open the Code Coverage Results view using the following steps, if this view is not opened yet:
*  From the main menu, select Windows > Show View > Other...
* Select Code Coverage > Code Coverage Results, and click OK

Right click inside Code Coverage Results view and select "Add Result Location...”

Click the "Local File System..." or “Remote Systems” button, browse to select the directory you

created at step #1 that contains all the *.cczip files, click OK

You should see a new result location in the Code Coverage Results view

Expand this result location, and you will see all the results

Double click on a result

A "File Level Code Coverage Results" report is opened in the editor area

Expand each of the source files in the File Report to reveal the procedures under it

Double click on a procedure in the File Report

An editor session is opened for the source file and the pointer is positioned to the selected

procedure

Now you can look at the code coverage annotation to see which lines are hit or not hit

© 2016, 2017 IBM Corporation



)
Cognitive Systems =

Why ACS and which ACS

 ACSis being invested in heavily by IBM and will continue to see enhancements.
— The emulator is best of breed

— Lots of SQL tooling, from building/executing queries to detailed performance analysis
— Itinstalls and runs anywhere (using Java)

* RDi will launch the version of ACS you already have installed if it is recent enough —
and you have access to all its other functions

(it is free from http://www-03.ibm.com/systems/power/software/i/access/solutions.html)

 If ACSis not installed, RDi will launch a copy shipped with RDi. As of RDi 9.6, the
bundled version of ACSis 1.1.7.1
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Run SQL queries from the selection in your

editor
Access Client Solutions (ACS) now has Run SQL Support. RDi provides tight

integration with it.
e Select the SQLRPGLE source in the editor
*  From the Source menu

[Source] Compile(G) Mavigate Search Project Data Run Window Help

Select Format Line...
Show Indentation
Show fields

Format

{ H 4 .
— Launch Run SQL SCFIptS New YUl iy~ [ Activity: Other Activity ~ i
Prompt F4
Syntax Check All
b clle  #*PAYROLLFFF..  # asqlpgle I/ *DUF
v ; B
- Verffy Crrl+Shift+V e 317 Column 35 Replace 11 change
54 Verify (Prompt).. +1+2+3=4
‘I¥ Visualize Application Diagram from f57rel
Convert All To Free-Form where b.rta:

a.rpre

Exec SQL

insert into empRome

select EMPNO,|

JCOPY Member 3 ellame,|
Launch Run SQL Scripts EDEP‘_t,
5

ILE RPG Help 4
from EMPMST e
Remove Messages where e.Locn = 'ROME'H
2 = F]
Refresh
< Refresh Qutline View Ctrl+Shift+F5 If SQLSev > '82';

LogMsg("'":@: 'Error ' + SQLSTATE +
' on F57rel in Startup');

CHINTC -

Work with members...
© 2016, 2017 IBM Corporation ¢ Library list
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Run SQL Scripts can be launched at any
time pe—

= O || B Demosen
£ & =T Line
+ <& Mew Connection - PR
- Ef Local of
As of 9.5.1 the RSS can be launched from the + B8 Demo server unu
. . . . |&® Opiacts var
Objects Subsystem and is not restricted to & New 3
. B IB Go Into |
SQLRPGLE members et q
g f: F Open in New Window ..
*FESE = Show in Table [
% Q @ Monitor |
4 [ Toro| # Open Member.. Cti+Alt+Q |
4 g ol
s N Work With L3 |
o |
44 &1 Refresh F5 |
- 3 Sort
Y {
) Disconnect
Clear Password
Change Password...
Release Interactive Job
Verify Connection...
[ Properti Remote Servers »
Show Log
Property Run Command...
Connec] Host Connection Emulator |
N TSt nth Riin sqQL Scripts f
MNumbj AuTC £ I
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Run SQL queries from the selection in

your editorx
* Launches the ACS Run SQL Statements

* Connects to the database on the system that the member was on
* Some editing my be required to replace RPG variables with literals, etc.

i T
= C:\Users\IBM_AD~1\AppData\Local\Temp\rdi351566643752194...

Eile Edit View Run Options Connection
HEL ¢ RB(FPFRO @

gelect empno,
e

name,
edept,
enhra

Totn G B

Mo aaCcaoase THT=C C T OIT

Connected to relational database M100BBSP on
emboxl.demos.ibm.com as REINHARD —
836359/QUSER/QZDASOINIT

1

Messages

Connected to relational database MIDDEBBP on embox1.demos.ibm.com as REINHARD - 8363...
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Run SQL queries from the selection in

your editorx
 However RSS does not set up the same LIBL as in RSE

* You can do this using one of the following commands:

CI:Chgl'bI ||b1 I|b2 ||b3, |l set achema reinhard;|
. Z select empna,

cl:call setmylibl;

set schema prodlib;

* You also should then set the naming to *SYS |

&5 JDBC Settings

B C:\Users\IBM_AD~ I\AppData\Local\Temp\rdi3515666437

File Edit View Run Options |Connection

S \ Naming convention: .SQL (*s5QL) -
TEE 2R FPD Connect to Database... i i IS L(*S0L '
| Decimal separator: QL (*5QL)

1 szet schema reinhard: Reconnect

B Time

g select s Disconnect :

4 edept, Format: | hh.mm.gs (*150) =
5 enhra JDBC Settings... S N r——

& from emomst Separator: | . (period)

Date
Format: | yyyy-mm-dd (*150) 'v_ '

Separator: |- {dash) hd

© 2016, 2017 IBM Corporation
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Select Run All and see the results

. Select Run All either from the toolbar or menu
. The results are shown in a tab on the bottom

*  The Messages tab shows the log of commands and results
{® c:\Us.ers\IBM_AD~1\AppData\Loca|\Temp\rdi351566643?52194...l = | E) S |

File Edit View Run Options Connection
EEE |+ 2R (FEFDPO @

1 set achema reinhd Ruyn All
A 2 select empno,
F S| ename,
4 | a edept,
E 5 enhrs
[ from empmst
7 where elocn = 'ROME' ;
> set schema reinhard
EMPNO ENAME EDEFT ENHRS
42154 PATRIZIO 2DFAD 40.0
Statement ran successfully (902 ms)
» select empno, ename, edept, enhrs from emprst Done. 1 rows retrieved.
where elocn = 'ROME' P Messages| select empno, ename, edept, enhrs from empmst where elocn = 'ROME'
Connected to relational database M100BBSP on emboxl.demos.ibm.com as REINHARD - 8363...
Statement ran successfully (1,686 ms = 1.686 L — ———— y

sec) el

Messages | select empno, ename, edept, enhrs from empmst where elocn = 'ROME'
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Visual Explain through ACS Cognitive Systems@

B Untitled - Run SQL Scripts - EMBOXL.DEMOS.IBM.COM(M100B... = | (=) i Sl
|
@ ®

|£i|e Edit View Run [VisuaIEprain Options Connection

— Visual Explain - common1.frankeni.com(COMMON1)
HEZ| % RE| Explain Ctri+E - - : ;
File View Actions Options

g SELECT un 2nd Eplan o H B9 BRIJAGD o e & F W 25 search Ignore Case
2 FROM MyTabl Explain While Running Ctrl+W Il &
3 WHERE Salar|

Attribute ' Value

Query Engin... SQE
Timeinfor.. | |
Timestamp... 2016-09-...
Statement S... 2016-09-...

£ ﬁ @ Statement E... 2016-09-...
H o | e R ¥

ect Sorted List Scan  Temporary Sorted List ~ User-Defined Table Function Total Estim... 1.956
: Actual Run..| |
Optimizatio... 2
. e Run Time (... Not Available
IBM | SpeCIfIC SQL Statement O... Not Available

Statement F... Not Available

query optimization Statement C... Not Available

Options 4

With TOP_CONSUMERS (JOB_NAME, MEMORY_ POOL, AUTHORIZATION NAME, FUNCTION_TYPE, Function,
TEMPORARY_STORAGE, RANK)
As (Select JOB_NAME, MEMORY POOL, AUTHORIZATION NAME, FUNCTION_TYPE, Function,
TEMPORARY_STORAGE, RANK()
OVER (Partition By MEMORY POOL Order By TEMPORARY STORAGE Desc)
From Table (QSYS2.ACTIVE_JOB_INFO()) X
Where JOB_TYPE <> 'SYS')
Select JOB_NAME, MEMORY POOL, AUTHORIZATION NAME, FUNCTION_TYPE CONCAT '-' CONCAT Function
As Function, TEMPORARY STORAGE From TOP_CONSUMERS Where RANK In (1,2,3,4) Order By
MEMORY_ POOL Desc

Sielculao el Optimizer Messages
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More ACS launch menus

v B v7rd Toronto
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H Results

B or——- @ schemas - PBADTOT.CANLABIBM.COM
B New ’ File View Actions
&8 Jo Go Into N [ Databases » Paadt7 & Schemas b REINHARD W Tables
& IF
=t GoTo >  System
|.=u SF Mame Mame Owner Definer La
= . )
L=b? o 'r'sﬁ Open in New Window CUSTSUMS ~ CUSTSUMS ~ REINHARD  REINHARD 09
1 ) DESLIMER ~ DESLIMER ~ REINHARD  REINHARD 09/
B viR1 B Showin Table ORDERS ORDERS REINHARD ~ REINHARD 08
. £ Column Masks QSRC QSRC REINHARD ~ REINHARD 09/
£l Monitor %COHS‘H‘”E RUTUTORIAL RUTUTORIAL REINHARD — REINHARD  09)
Functions
/ OFIEFI Member... Ctrl+Alt+Q -3¢, Global Variables
-y Indexes
Work With iourna:sR ) &9 IBM i Access Client Solutions O *
ournal Recelvers
& Procedures
& Refresh -T7) Row Permissions
i Sequences
Sort e S File Edit Actions Tools Help
Disconnect Egg:rs 2
_ % Views System: | p8adtD5.canlab.ibm.com -
Clear Password NLAB BMCOM K XML schema Repository (¥5R)
mmunication Action General
Change Password... ™o + Data Transfer
Release Interactive Job IRIEERSd 54 5250 Emulator
Integrated File System
Verify Connection... Navigator for i
Printer Qutput
Remote Servers
[ Database ]
Schemas F
Show LDg Run SQL Scripts
Run Command SQL Performance Center
. Console
Host Connection Emulator 5250 Console
. Virtual Control Panel
Launch Run 50L Scripts !
Q P Hardware Management Interface 1
Launch 5chemas
Launch 5250 Emulator [ Eigaement
= [ X J7R0TOS CAMAB BH.CONZ3 System Configurations
Launch Access Client Solutions 5250 Session Manager
» HMC Probe Utility
= y
Properties Alt+Enter >
Lo i B - - -

46



)]
Cognitive Systems =

Improvements to new ACS shipped with RDi 9.6

July 2017 - Version 1.1.7.1

General enhancements:

Option to disable end users from accepting "trusted" signers (RFE 99153)
Option to enable SSL by default (RFE 100725)

Enable "Check for updates" from command line (RFE 96516)

Provide better error details (RFE 99599, RFE 105977)
Enhancements to 5250 Emulation:

Screen History Archiving

Toolbar buttons for launching Navigator for i, Schemas, and SQL Performance Center
Enhancements to Printer Output:

Combine date/time into single column with most current entry displayed first (RFE 93655)
Date/Time filter (RFE 99212)

Filter Reset button (RFE 104310)
Enhancements to Data Transfer:

Automatically truncate extra columns during upload (RFE 106407)
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ACS 1.1.7.1 enhancement contd

— Enhancements to Schemas:
* Added Health Center
* Additional filters for object folders
* Action for checking permissions
* Added View Entries to Journals
— Enhancements to Run SQL Scripts:
* Added SQL Performance Monitor
* Added headings to text type output (RFE 91120)
— Enhancements to SQL Performance Center:
* Added Import SQL performance data
* Support for adding SQL Performance Monitors, Plan Cache Snapshots, SQL Plan Cache Event Monitors
* Properties for SQL Performance Monitors, Plan Cache Snapshots, and SQL Plan Cache Event Monitors
— Enhancements to Visual Explain:
* Added icon Help text
— Several fixes

© 2016, 2017 IBM Corporation
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Improvements to new ACS shipped with RDi 9.5.1.2

List of ACS enhancements

 March 2017 - Version 1.1.7.0
 Many actions on database objects
* Such as:

© 2016, 2017 IBM Corporation

Manage definitions
Generate SQL
Work with properties
Object rename
Create new database object
Show object references
Index advisor (raw and condensed)
Explain SQL
Table data actions
* (view, clear, copy, initialize)

&Y Schemas - i7adt06.torolab.ibm.com

File View Actions

[ﬁ Databases

<
"

[T Databases » J10ea08e b Schemas b ADTSLAB B Tables

= Ry J10ea0se
= (@ schemas System
=) [ ADTSLAB Name Name Owner Definer Last Alt
G5 Al Objects ADTSLABSV ~ ADTSLABSV ~ QDFTOWN  BRUCE 04/13/2
& Aliases ALLTYPES ALLTYPES QPGMR *BM 04/13/2
g Constraints APPSOURCE ~ APPSOURCE ~ QPGMR *BM 09/21/2
Functions jcUSTOMER  [cUSTOMER __fopeMR _____[*1BM ________[04/13/21
. Global Variables b
x= CUSTOMO1  CUSTC Definition L
& Indexes st ust t
Journals MODEL MODEL Generate SQL... (
Journal Receivers MULTIRECP ~ MULTEF Reset Usage Counts... (
Procedures
B MULTKEYS . MULTK Statistic Data t
it Sequences PARTORDER PARTC 4
@ SQL Packages PRODDTL PRODC Comments... ‘
m PRODDTL_0  PRODE ) «
j’ Triggers PRODDTLSV  PRODO Index Advisor >k
‘I Types PRODINV  PRODI (
Views PRODLIST PRODL Work With >
H}) XML Schema Repository (XSR) | | |bRODPRICE  PRODF ¢
3, OmniFind Text Indexes PRODSHOW PRODS Data >k
® [ QUSRSYS PRODUCT  PRODL £
# @& REINHARD QAQQINI QAQQY Delete... Delete k
3 (@ lasp33 QCLSRC QaLsR Rename... Ctrl+Shift+R [
QCSRC QCSRC L
QDDSSRC ~ QDDSS New >
SETUPCLSRC  SETUP( L
SETUPCMDSR  SETUP{ Description L
[TABLE1 TABLET QUFTOWIN SCHWEYER s/ 1372
TABLE2 TABLE2 QDFTOWN ~ SCHWEYER  04/13/2
[TARI F3 TARIF3 ONFTOWN SCHWFYFR nNa/13/2¢
<
Done: 31 rows retrieved.
49
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Improvements to new ACS shipped with RDi 9.5.1.2

e Enhancements to Run SQL Scripts
— Added CL Prompter
— Added upload results
— Improved formatting
— Enhanced SQL highlighting

— Many new 'Insert from Examples'
(built using SQL Services)

e January 2017 - Version 1.1.6.2
e Enhancements to Printer Output filter:
— multiple output queues

— User-Specified Data

© 2016, 2017 IBM Corporation
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(LR

2l

- .
i % Untitled™ - Run SOL Scripts - i7adt06.torolab.ibm.com{)10ealge)

Undo
Redo

Cut

Copy
Paste

Select All

Find
Find Mext
Find and Replace

SOL Formatter
Teggle Comments

Insert from Examples...

Prompt CL...

q File Edit View Run VisualExplain Options Connection

Ctrl+Z ¥ g g |

Ctrl+¥

Ctrl+X
Ctrl+C
Ctrl+V

Ctrl+ A

Ctrl+F
3
Ctrl+H

» Format Selected  Ctrl+5hift+F

Ctrl+5lash Configure...

% HE GLOBAL VARIABLE EXISTS OR ENSURE THE SCHET

[ Wed Apr 26 18:50:19 EDT 2017 ] Syntax Check...
% Select * From Customer where CUSTNG ='1'
¥ Syntax check completed successfully
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Modernization Tools, Java Edition

 Added WAS 9 tools, dropped WAS 7/8 tools
* Using Rational Application Developer 9.6.1 components

B ’:I [J IBM® Rational® Developer for i 9.6.0.0
[w] % RPG and COBOL Tools
Sy 2§ ioccrnization Tools, ava Eition
% Web and mobile developer tools
Bluemix tools
Cordova tools
“ IBM i and enterprise web developer tools

|

EXIOO

5

= WebSphere® Application Server tools

WebSphere Application Server Liberty tools

WebSphere Application Server classic 9.0 tools

WebSphere Application Server classic 8.5 tools

WebSphere Application Server Liberty Portal tools

WebSphere Portal Server 9.0 tools

WebSphere Portal Server 9.0 on WebSphere Application Server 8.5
WebSphere Portal Server 8.5 tools

WebSphere Portal Server 8.0 on WebSphere Application Server 8.5
WebSphere Application Server test and performance tools

clipse Git Team provider

MOOOOOAAEE
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developerWorks > RFE Community > Servers and Systems Software

Servers and Systems Software
RFE Community

Qverview Search Submit Releases My stuff Groups Help

Welcome users! Here you have an opportunity to collaborate directly with the product development teams and other

I . . .
http://ibm.biz/rdi rfe productusers Your ideas matter!
Filter the page content by brand and product
Servers and Systems Software ¥ Developer for Power Systems M 4
As of today:
Hot Top New Search o 1
122 RPG refactoring ability new
H H votes  Would like to be able to perform refactoring on RPG code similar to the refactoring Eclipse can do with C++.
Delivered in 9.5.1.1 : ! I 0 planned
v Y9 petactor > Rename p
Refacter = Extract Local Variable
Refacter = Extract Constant K
Refactor . 120 delivered
Uncommitted Candidate
. . 118 Function to indent/format existing code similar to how "Source/Convert All ...
DEI|Ve rEd n 9 5 votes  Vyould like to see a function to indent/format existing code.  Could work similarly to how "Source/Convert All to Free-
Form” works now, as well as "Cenvert Selection to Free-Form. on the context menu. 2’15 users
Delivered

5013 votes

2166 comments

29 support for mac in rdp
Dellvered 18] 951 votes  jwant to be able to run the ROP on my mac native
Voted  Delivered

75 Identify where in the code you are at.

Dellve red |n 9 ,5 . 1 votes  \When editing or browsing through a source member in the LPEX editor, it would be helpful to know in what subroutine
or procedure you are at.  This would eliminate the need to find BEGSR Previous.  SIm

© 2016, 2017 IBM Corporation Delivered


http://ibm.biz/rdi_rfe

Delivered in 9.0.1
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Delivered in 9.5.0.3

Delivered in 9.5.1.1

Delivered in 8.5.1

Delivered in 9.5.1.2

Delivered in 9.5.1

Delivered in 9.5.1

65
votes

55
votes

51
votes

42
votes

Live Update of Content Assist

In RDP 8.5, we received live outline refresh, which is great.  However for me, | always associated the outline with
content assist.  Except the content assist does not have visibility of the live outl...

Deliversd

Integration of iIBM i Access database functions into RD Power

While bringing back the Database perspective was a step in the right direction, the IBM | Access database functions
are much more complete, especially Visual Explain
I'd like to see the [BM i Acces.

Deliversd

Add preference to default all opens to be browse only.

I want all my epens from features that allow a choice  to default to browse unless | choose other wise on that open
selection.

Uncommitted Candidate

Update outline view constantly

The outline view should be constantly updated with the new information from the editor when the user changed the
source code in the LPEX editor. At the momemt  the user has to click the refresh button...

Deliversd

Trim Leading Spaces when joining lines (alt-J)
Being able to join lines with alt-J is very nice. [t would be preferable if the join would trim off leading spaces of what
is being jeined and possibly add a single space so the join doesn't but up d...

Uncommitted Candidate

From a SQLxxxLE source, a "SQL prompter” on SQL lines
From a SQLxxxLE source, a "SQL prompter” on SAL lines as we can have in SEU with the F4 function key

Uncommitted Candidate

Filter Outline by Referenced/Unref
Provide a means to filter fields/procedures/prototypesfetc by whether or not the moedule uses them

Deliversd

Automatic Content assist should be available as a preference
In the early days of WDSC centent assist was automatic as it is with mest other tocls based en Eclipse. That
capability was removed and we now have to use Cril/Space to activate. This makes sense for

Delivered 53
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RD1i Fix List — RFEs delivered

. upport for ILE RPG %PROC buili-in function. For mora information, sae the documentation in: hitp:
re I e as e/fl X aC k s upport/knowledgecenter/SSAEAW_0.6.0/com.ibm.etools.iseries ilerpg.ref. doc/topics/bbproc.htm

p RFET0905 ompare Dossn't Mergs from RSE. The Compare tool in RSE now enables the merge features when comparing remote 18M i
members. Previously, this was only available when comparing local members in i Projects or when comparing local | Project
[members with their corresponding remote members in Remote Reconciler. In addition, differences like sequenca numbers

® 1 8 R F ES I n R D I 9 5 1 lean nowr be properly displayed using the Text Compare option in the Compare tool 2nd will allow you to better synchronize
. . [end merge contlicts, for example, when using eGit tools. NOTE: If multiple compare editors are open for the same source

fnembars edit mods will be disablad.

v ibm.com

. - RFES2757 [Error tist does not position to correct source ling if any source lines have been added or deleted. Error List messages are
Y 7 R F ES I n R D I 9 5 1 l lnow displayed as annotations in the editor instead of inserted as pink inline message text. Double clicking on verify or

- . . mpile errors in the Error List view, will open the source membey, insert the messages as ennotations, highlight the code in
[error and allow you to hover over the code and elick on a link to get the second level message help. If you prafer to go back
B B 0 the style where messages are inserted as text in the source, select the View Menu -> Message Style -> Show messages as
® 5 R F ES I n R D I 9 5 1 2 knnotations {drop down arrow icon on the right hand side of the Error List view). Note: Syntax check errors are also set to

. . . Kizplay messages as annotations by default. To turn this off, £0 to Window -» Preferences, then select Remots Systems >
Remote Systems LPEX Editor > 18M i Parsers. Uncheck “Display syntax check messages as annotations”. Issue: Annotations
. . -annot be property displayed for some DDS compile messages and should be tumned off for this case. This is a known issus
[ 1 2 R F ES I n R D I 9 6 fnd will be corrected. For more information, see the documentation in:https:/fwww.ibm.com/support/knowledgecenter

. SSAEAW_0.6.0/com.ibm etools.iseries.rse.doc/topicsjt_error_message_style hml

RFE35074 hange behaviour of TAB-key for firee lines. The Tab key will now insert spaces into free form ILE RPG source lines when
[pressed. Shift+Tab will cutdent the free form line. If you select one or more frae form lines and press Tab or Shift+Tab it will
norease or decrease the indent respectively. To change the number of spaces used, go to Window - Preferences, then
fpelect Remote Systems > Remots Systems LPEX Editor > IBM i Parsars -> ILE RPG -> Formatter. Set the value in ‘Number of
[ep=ces to indent by, If you prefer to go back to the behavior where Tab and Shift+Tab behave the same way on free form
ines as fixed form lines, £0 1o Window -> Preferences, then select Remote Systems > Remote Systems LPEX Editor > TBM i
[Parsers -> ILE RPG -> Key Behavior. Uncheck ‘Tab key inserts spaces for frae form source.’ Note: The "Key Behavior'
[preference now includes all Key behavior sertings previously found in the parent ILE RPG preferance. Two new settings
ere added: Tab kay inserts spaces for free form source. for RFE36974 and ‘Enter key splits line for free form source’ for
RFE25265.
RFE25265 |.PEX Editor behavior when enter pressed/delete prassed. The Enter key will now split the line when Enter is pressed on free
rm ILE RPG source lines. The delete key has not been enabled 10 jain lines, o Alt+] should still be used to join lines.
RFE25265 has been partially implemented and will remain open. If you prefer to £0 back 1o the original behavior for the
[Ent=r key, g0 to Window - Preferences, then select Remote Syatems > Remate Systems LPEX Editor > I8M i Parsers -» ILE
RPG -> Key Behavior. Uncheck ‘Enter key splits line for free form source’ Note: The 'Key Behavior' preference now includes
[Ell Key behavior settings previously found in the parent ILE RPG preference. Twe new settings were added: ‘Tab key inserts
[epaces for free form saurce' for RFE36874 and ‘Enter key splits line for free form source' for RFE25265.

RFE74270 how comtextual warning about unused local variables. Waming annotations are now displayed in the editor for any
unreferenced definitions. To turn this off, go to Window -> Preferences, then select Remote System LPEX Editor > 1BM i
[Parsers » ILE RPG. Uncheck “Annotate unreferenced definitiona®. For more ion, s=e the documentation in:
ps:ffurww.ibm.comy! j ter/SSAEAW_9.6.0/com.ibm.stools.iseries.rse.doc/topicsftannot_unref.html
RFE103832 Recognize fields renamed in RPG I-specs in RDi live outline. ILE RPG Fields that are renamed by extemally-described
-Specs are now fully supported.
RFE104305 [RDi search should include PF38-SRC as well as PF-SRC
RFES06E2 LE RPG Display Parameters When Hovering Over External Procedure Calls
RFET7545 [Trim Leading Spaces when joining lines {sit-3). Nota: This now supports CL in addition to RPG.
RFE4070L horteut in Iprojects for Remote Actions - Push Selected, Compile Commands. i Project short cut key Alt+Shift+B can now
lpe used 10 launch & project build and Ctri+Alt+R can be used from within the editor to retrieve erors from the last project
fpuild
RFE26030 LE RPG Named indicator should sppear in the Fields section of the Outline view
RFEBSE66 BM i command line tools for code coverage. PTFs are now svailabls for 1BM i 7.2 and 7.3 for RDS option 60 that provide:
mmand line tools to invoke code coverage. The output is imported into RDI to view the results. 54
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Future Product Goals

 Make RDi the most compelling development tool for the IBM i
* Make it seamless for SEU/PDM users to upgrade
e Attract young development talent to platform

* Improve the effectiveness of IBM i developers
— Software Engineering — Refactoring/Automated Test/Code Coverage
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Conclusion

* RPG is evolving rapidly and RDi is keeping pace (SEU is not)

» Free-form RPG and RDi solves skill-depletion

» Goal to make green screen developers more comfortable and productive
» Lot’s of goodies in RDi 9.6 — worth upgrading

« Organization effectiveness enhanced through software best practices

« We are prioritizing investment according to your feedback via RFE

With RDi, IBM i programming is cool and productive!
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Resources
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Rational Developer for i 9.6
—http://ibm.biz/rdi

product — purchase, what’'s new

—http://ibm.biz/rdi

product_evolution — is this an update, technical details

—http://ibm.biz/rdi

fix_list— list of all enhancements and fixes by release

—http://ibm.biz/rdi

install — options for enterprise installation

—http://ibm.biz/rdi

roi — personalized business case generator

—http://ibm.biz/rdi

wiki_self learning - lots of online learning resources

—http://ibm.biz/rdi

documents - documentation and notices

How to stay in touch

—https://ibm.biz/rdi_hub — community, blog, announcements, wiki, links, resources

—https://ibm.biz/wdsci-l - very active discussion group

—http://ibm.biz/rdi

rfe - request for enhancements

—LUG requirements |, q/

~COMMON


http://ibm.biz/rdi_product
http://ibm.biz/rdi_product_evolution
http://ibm.biz/rdi_fix_list
http://ibm.biz/rdi_install
http://ibm.biz/rdi_roi
http://ibm.biz/rdi_wiki_self_learning
http://ibm.biz/rdi_documents
https://ibm.biz/rdi_hub
https://ibm.biz/wdsci-l
http://ibm.biz/rdi_rfe
https://www.ibm.com/developerworks/rfe/execute?use_case=recentlyVoted&BRAND_ID=352&PROD_ID=195
http://common.org/

